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Integration Overview 
Thomson Reuters offers a cloud-based integration of ONESOURCE Determination with SAP 
Business One for countries with Value Added Tax (VAT) regime. ONESOURCE Determination 
integrates with SAP Business One through the SAP Business One DIAPI, an integration platform 
that exposes Business One data and services, maps ONESOURCE Determination fields to the SAP 
Business One fields and returns the Calculated Tax amounts and rates. 

This integration will support the following events from SAP Business One. 

• Estimate Tax Calculation Calls for Sales Quotations, Sales Orders, Purchase Quotations and 
Purchase Orders 

• Audited Tax Calculation Calls for Accounts Receivable Invoices and Cancellation of A/R 
Invoices, A/P Invoices and Cancellation of A/P Invoices 

• Estimate and Audited Tax Calls for Sales Returns or A/R Credit Memos, Purchase Returns 
or A/P Credit Memos 

ONESOURCE Indirect Tax Determination using the REST API for SAP Business One is supported 
for the SAP SQL Version. These extensions would work for both the on-premises environment and 
cloud cluster. In addition, with this release, HANA DB compatibility is now supported.  

Prerequisites 

This integration is supported for SAP Business One (SQL) version 10.0 or higher for both On Cloud 
and On-Premises deployments. In addition, HANA DB compatibility is now supported.  

 
For a successful implementation of the integration with SAP Business One, please ensure you have 
procured the necessary packages and followed the implementation steps outlined below: 
 

Platform Component Description 

SAP Business One Local and Cloud 
environment 

• Add and activate the Thomson Reuters SAP Business 
One extensions to the system setup. 

• Build and update the system with VAT localization 
settings to activate the extensions. 

• Maintain relevant system configuration for various 
integration options including connection details and 
authentication options. 

ONESOURCE 
Determination 

Cloud 
Environment 

• Set up of the External Company ID that uniquely 
identifies the tax request within the ONESOURCE 



 

Determination solution for audit, reporting, and 
returns purposes. 

• OAuth2 authentication details are required to set up 
the integration. 

 
 

Architecture and Design Overview 

 

The Thomson Reuters ONESOURCE Determination Integration with SAP Business One uses the 
Service Layer to seamlessly connect to the Indirect Tax Calculation REST API.  

This extension or add-on needs to be added to your setup to trigger and manage the tax calculation 
calls.  

To support this integration, you will need to have some additional fields on your marketing 
documents in SAP B1. These fields provide extra information needed for the tax breakdown. 

To display the calculated taxes from ONESOURCE Determination, this integration utilizes the 
Freight Setup functionality within SAP Business One to define the various levels of authorities. 
 
For security purposes, authentication and client credentials will be verified with every tax call. Your 
credentials are securely stored under the company setup. 
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Known Limitations 

• The tax integration supports only one delivery addresses per document. Taxes will be 
determined based on this address. 

• The Summarization feature is not yet available for this release.  

• Batch processing of invoices for both sales and purchase processes are not supported. 

Business Process Description 
Order to Cash Process  

Here the tax determination within SAP Business ONE is supported right from the quotation 
transaction. The quote will call ONESOURCE Indirect Tax Determination for tax calculation but will 
not record the tax liability (commit the transaction). After the quote is converted into an order, 
ONESOURCE Indirect Tax Determination will again be called to update the tax amount as it could 
change due to factors such as dates, pricing, quantities etc.  
 
Depending on the tax jurisdiction, shipping costs that are added in the sales order could be a taxable 
or non-taxable event. After the shipping process, an invoice is generated and ONESOURCE Indirect 
Tax is called again for a final update of the taxes. Once the final invoice is created, ONESOURCE 
Indirect Tax Determination is updated by a final commit tax call with the tax liability stored for future 
reporting and returns processing.  
 
A Correlation ID is generated for each document, which can be used for audit, tracking and 
reconciliation purposes. 
 

The business processes covered by this integration are:  

• Sales Quotes  

• Sales Orders  

• Sales Invoices  

• Credit Memos  

• Invoice Void/Cancellations   

Procure to Pay Process  

Similar to the Order to Cash process, tax determination within SAP Business ONE is supported right 
from the purchase quotation to AP invoice transaction. The quote will call ONESOURCE Indirect Tax 



 

Determination for tax calculation but will not record the tax liability (commit the transaction). After the 
quote is converted into a purchase order, ONESOURCE Indirect Tax Determination will again be 
called to update the tax amount as it could change due to differences in dates, pricing, quantities etc.  
 
As well, depending on the tax jurisdiction, shipping costs that are added in the purchase order could 
be a taxable or non-taxable item. After the shipping process, a purchase invoice is generated and 
ONESOURCE Indirect Tax is called again for a final update of the taxes. Once the final invoice is 
created, ONESOURCE Indirect Tax Determination is updated by a final commit tax call with the tax 
liability stored for future reporting and returns processing.  
 
A Correlation ID is generated for each document, which can be used for audit, tracking and 
reconciliation purposes. 
 
Within the purchase invoice, this solution also integrates with the ONESOURCE Determination 
Vendor Charge Tax Verification (VCT-V) functionality. This feature automates the decision-making 
process to support and handle differences between ONESOURCE Determination calculated tax and 
the vendor charged tax by using the ONESOURCE Determination VCT-V functionality for vendor 
invoices. 
 
In this solution, we are not using the default SAP Tax engine to calculate taxes. Instead, post-
installation, it is necessary to create an "INA" tax code for purchases and an "ONA" tax code for 
sales, both set at a 0% rate. These codes will be utilized by the tax determination process. 
 
By using this approach, we ensure that the correct tax amount is accounted for while meeting the 
necessary legal regulations. 
 
 
The business processes covered by this integration are:  

• Purchase Quotes  

• Purchase Orders  

• Purchase Invoicing  

• Purchase Credit Memos  

• Invoice Void/Cancellations   

How does integration work? 

Display of Tax Authority Levels 

In VAT countries, each taxation authority imposes the tax based on jurisdictions. After taxes are 
determined for each authority from ONESOURCE Indirect Tax, it gets assigned to relevant tax 
authority levels in Business One. In this integration we have mapped the following tax authority 
levels based on the effective zone levels as follows: 
 

Business One Tax Authority Level Effective Zone 

TR_iVAT (for Purchase Transaction) Country 

TR_oVAT (for SalesTransaction Country 



 

 
This integration utilizes the Freight Setup functionality within SAP Business One to define the 
various levels of tax authorities determined from ONESOURCE Determination. 
 
To access Freight Setup: In SAP Business One, navigate to Administration > Setup > Financials 
> Freight Setup. The various breakdown of the taxes will be set up automatically when you import 
the extension. 
 

 

Tax Code Usage  

• With this solution, you are no longer required to set up tax codes as the SAP default Tax 
engine is not used. A default tax code of “INA” (for purchase) and “ONA” (for Sales) will be 
created automatically during the installation process.  

Freight - Setup

Name Revenue Account Expense Account Output Tax GroupInput Tax GroupFixed ...
1 Freight Charges 445710

TR_iVAT 445660 445710

TR_oVAT 445660 445710

OK Cancel

 

    

   
   
   

 



 

 

• After entering all the details of the document, such as customer, date, reference, items 
details, unit price, quantity, discount (line and document level), warehouse (ship from 
location), and the ship to location, the user is required to click on the “Calculate” button to 
check and see the tax amount for the transaction. 

• If any changes occur after calculating the tax and you attempt to save the transaction without 
recalculating, the system will automatically trigger the recalculation and apply the correct tax 
amount. 

• Once all necessary information is entered and the system calculates the tax based on the 
address and jurisdiction, the tax amount will be displayed in the freight table, as shown in the 
image below. This window provides an overview of freight charges, other fees, and 
jurisdiction-specific tax details for final posting. 

 

Form Settings - A/R Invoice

Select UI Template Apply

Table Format Row Format Document
Find Next

Column Visible Active
Standard Item Identification

?

oVAT Rate ÿ
?
?
?
?
?
ÿ
?
?
?

Restore Default

 

  

   
 

   

 
 

  
 
 
 
 
 
 
 
 
 



 

 
 

• If charges have no distribution method, the total tax amount and consolidated tax rate will be 
displayed in the Tax Rate and Tax Amount fields, while the Net Amount field will show the 
overall total. 

• This solution supports Vendor Charged Tax (VCT) functionality during the purchase process, 
with different accrual methods. One exception to this rule: If the VCT amount is beyond the 
tolerance limit then system will show “HOLD PAYMENT” accrual method.  

• If the accrual method is HOLD PAYMENT, the system will prevent posting the transaction 
until the user modifies the details or the system receives another accrual method. In such 
cases, users can save the document as a draft and later finalize it. 

Installation and Set Up 
Importing an Extension 

• Download the SAP Business One TR Indirect Tax Extension (Add-on) from Thomson 
Reuters Customer Centre. You need to have a valid subscription of the solution. 

Sales Order

Customer >CUS0001 No. 2350 230300025
Name Paris, FR Status Closed
Contact Person ÿ Posting Date 01.09.2023
Customer Ref. No. test Delivery Date 01.09.2023
BP Currency ÿ USD 0.983400 Document Date 01.09.2023

Sales Tax & Freight

Contents Dg Not Display Freight Charges with Zero Amount

Item/Service TypeIte Freight Name  Remarks:Tax Group% xe1 Total Tax Amount D.
Item No. Item Dest1 TR_oVAT ONA 0.00 0.00 USD No

ITM00001 Item 1

OK Cancel

Sales EmployeeNo Sales Employee- III

Owner
Total Before Discount 1,000.00 USD
Discount %

 

     
    

    
    

      

 

  

        
        

 

  

  
 

 
  

 



 

• Log in to SAP Business One Extension Manager, go to Administration> Add-ons> Add-on 
Administration and then click on Extensions > Import. 

• The Extension Import Wizard window appears. Choose the Browse button to locate the zip 
file of your extension and choose Upload. Follow the prompts to complete the setup. 

 

Assigning an Extension to a Company 

• After performing the import, go to the Company Assignment tab. From the company list, 
select the company to which you want to assign the extension. Choose Assign to complete 
the setup. 

 

Specify Startup Mode  

This is an on-time activity to default the Extension Startup Mode or to change a startup mode for a 
specific user.  
 
 To automatically run the extension for all transactions, from the Specify Setup Mode tab, select the 
default startup mode of this extension and specify the user preferences, and choose Next. 
 

SAP SAPBusiness One Extension Manager Welcome B1SiteUserSystem Landscape Directory.Help 

Extensions ÿÿÿ Company Assignment Security Settings ServerB1APPSYS
ÿÿÿ

Import Remove +

Name Type Version Provider Parameters Force
Install Status More Info

TR Indirect Tax Solutions LightAddOn 1.0.0 Thomson Reuters Edit OK Details
TR Indirect Tax Utility OK Details

Extension lmport Wizard
TR Indirect Tax Utility CA OK Details

TR Indirect Tax Utility VAT OK Details

Upload TR Indirect Tax Utility VAT.zipBrowse Upload

Specify Shared Parameters

Finish

SAP SAPBusinessOne ExtensionManager Welcome B1SiteUserSystem Landscape DirectoryHelp (

Extensions Company Assignment Security Settings ServerB1APPSYS

Company List Database Name DB_France Company NameSAP DEV FR Business OneVersion 1000180

TRTEST
DB_CANADA Extensions
DB_France Assign Unassign

Name Type Version Provider Enabled Settings Status

TR Indirect Tax Utility VATLightAddOn 1.0.2 Thomson
Reuters Edit OK

    

      
 

   

      
   

       
   

 
   

   

    

 

     

     

       

 

  
   

       

    
  



 

We recommend that you set the default startup mode to Mandatory, so that the extension starts 
automatically to enable all transactions created within SAP Business One to apply the 
ONESOURCE Indirect Tax Determination application. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 

Running the Extension in SAP Business One 

After you assign the extension to a company, the SAP Business One client will automatically load 
the extension the next time you log on to the company. If you have set the startup mode to 
Automatic, you now need to manually start the extension each time you log in. 

From the SAP Business One Main Menu, choose Administration> Add-Ons> Add-On Manager. 
Select the extension and click on Start.  

The SAP Business One client will start the system configuration and create the required fields and 
tables. 

 

X ÿ

Main Menu
SAP DEV FR Business One Add-On ManagerJafeuew

Madules Drag & RelateMy Menu Installed Add-OnsPending Add-OnsFailed Add-Ons for Lightweight Development
ÿ Administration Add-On IDPartner Name Add-On Name Status Group VersionPla.

Choose Company 18150 Thomson ReutersTR Indirect Tax Utility VATConnectedAutomatic 1.0.2 t9x

Exchange Rates and Indexes

System Initialization

Setup
Data Import/Export

ÿ

ÿ Approval Process

License

Integration Service

Add-Ons
Add-On Manager
 Add-On Administration

Mobile Add-On
Workflow OK yeis

Alerts Management

Extension AssignmentSettings

Parameters DefaultStartupMode Mandatory

Startup Mode

UserPreferences

UserName StartupMode

manager Default

B1i Default

Workflow Default

Support Default

AlertSvc Default

EDsUser Default

  

 
 

  
      

       
       

 

 

 
 

 

  

 

 
 

 

 

 

   

 

   

 

 

  

  

  

  

  

  

 



 

 

Connecting SAP Business One to ONESOURCE Determination 
 

This section outlines the configuration steps required as an initial set up to connect your SAP 
Business One client to ONESOURCE Determination. 
 
Company Setup 

A custom TR menu is now available to carry out the relevant configurations for this integration. From 
the Main Menu, go to Administration> Setup> TR Configuration. 
 

 
 
Fill in the required information as follows: 
 

Field Description 

Company Name 

The company name and 
corresponding branches will be 
automatically loaded.  

TR Internal ID 

This is the External Company ID 
within ONESOURCE 
Determination that uniquely 
identifies your company for its 
rules, rates, and other processing 
logic to be applied.  

TR Client ID This is the client id required for 
OAuth2 authentication of the tax 

File Edit View Data Go To Modules Iools Window Help

Administration Choose Company
Web Client

Main Menu 1 ÿ

e System Initialization
TRTEST
manager Sales - A/R General

Mgdules Drag & Relate Purchasing - A/P Data Import/Export Financials

Administration 8 Business Partners Utilities Opportunities

ÿ Banking Approval Process Sales 1

Financials
8 Inventory Purchasing

CRM Resources Integration Service Business Partners

e Opportunities Add-Ons Bankingÿ
1

Sales - A/R Workflow
ÿ Service Alerts Management

Purchasing - A/P
Human Resources Service

00 Business Partners Reports Production
ÿ Banking
8 Inventory

   

  
 

  

 

  
 

   

     

     
    

 
 

   
    

     
 

  
   

   
    
  

 



 

calls. Obtain this information from 
your Professional Services team. 
 

Secret ID 

This is the client secret Id required 
for OAuth2 authentication of the 
tax calls. Obtain this information 
from your Professional Services 
team.  

 
 
 
 
 

 

Maintaining ONESOURCE Determination URL  
Go to the Other Settings tab and enter the Determination URL as provided by Thomson 
Reuters. This is a one-time set up.  
 

 
 

Functional Configuration 
General Ledger Set Up 

To define the General Ledger (G/L) accounts for the various tax levels in the integration. By defining 
the G/L accounts for each tax level in the Document Settings, you ensure that the integration 
correctly handles the posting of taxes to the respective G/L accounts based on the determined tax 
jurisdictions. 

TR Configuration

Company Info HeaderAttribute Line Attribute OtherSettings

Company Name TR Client ID TR Internal ID Secret ID

1 SAP DEV FR Business One j\W65Er5NjzYPVV4qw1DA0vcpEEjeeZ4EH INTSAPDEVFRBusinessOne VDmG3rpkxvJO684y

TR Configuration

Company Info Header Attribute Line Attribute Other Settings

Product Code Item Code

URL https://api-cloud-sat.onesourcetax.com

 

    

    

    

 

    

  

 



 

 
From the SAP Business One Main Menu, navigate to Administration > System Initializations > 
Document Settings. 
 

 
 
Scroll down and locate the "Freight Setup" section. Click on Freight – Setup button. 
 

 
 
Within the Freight Setup section, you will find options to define the G/L accounts for different tax 
levels or jurisdictions. 
 

File P3 View Data Go To Modules- Tools Window Help SAPDEVFRBusil

ÿ Administration Choose Company
Financials Web Client

Main Menu CRM Exchange Rates and Indexes
Opportunities System Initialization Company Details Look up master data a

SAP DEV FR Business One
manager Sales - A/R Setup General Settings

Modules Drag & Relate Purchasing - A/P Data Import/Export Posting Periods

Administration Business Partners Utilities Authorizations

ÿ Banking Approval Process Document Numbering
Choose Company

ÿ Inventory License Document Settings
Web Client Resources Integration Service Print Preferences

Exchange Rates and IndexeProduction Add-Ons Menu Structure

System Initialization MRP Workflow Menu Alias for Searching
Service Alerts Management E-Mail Settings

Setup
Human Resources Opening Balances

General Implementation Center
1 Financials Tooltip Preview

Opportunities

Document Settings

General Per Document Electronic Documents
Calculate Gross Profit

Base Price Oriqin Last Purchase Price
Default Gross Profit % for Service Documents 0.00

Calculate % Gross Profit ast
O Profit/Sales Price  Profit/Base Price

Document Remarks Include:
 Base Document NumberO Manual Remarks OnlyO BP Reference Number

For a Sales BOM in Documents, Display:
O Price and Total for Parent Item Only O Price for Component Items

Response to G/L Account Balance Outside Allowed Range!
without Warning O Warning Only O Block Posting

Response to Release / Receipt of Inventory Outside Defined Range
OWithout Warning  Warning Only O Block Release / Receipt

Block Negative Inventory By Item Setting
Rounding Method

 By Currency
O By Document

Exchange Rate Base Date (A/P Documents) Document Date
Split Journal Entry Posting by Document Lines No Split

 Display Rounding Remark
Use Warehouse Address

 Manage Freight in Documents Freight - Setup
Block documents with earlier Posting Date

Allow Future Posting Date
Use Document Exchange Rate When Copying to Target Document

Attachments
Copy Attachments from Base Document to Target Document
Copy Attachments from BOM to Production Order
Do Not Overwrite Attachments with the Same File Name

          

   
  

 
  

   
 

 

    

     

    
    

 
    

    

    

    
   

 
  

 
 

   

 

   
 

  
  

 
  

 
  

 
  

 
   

 
   

  
 

 
 

  
  

 
 

  
 

 
 

 
 

 



 

 
 
This section provides guidance to assign the appropriate G/L for the following processes. These are 
only recommended G/L account set up, please work with your G/L accountant to define the correct 
accounts for your company. 
   

G/L setup for Sales Process   

Maintain the appropriate G/L account under the Revenue Account setup at authority level.   
  
For VAT Countries, the following authority level is defined.  
  

Tax Account  Description  
TR_oVAT G/L account where the country authority tax amount will be posted to 

under the Revenue Account setup.  
  

G/L setup for General Purchase Process  

Maintain the appropriate G/L account under the Expense Account setup at authority level. This 
would be the required setup to support the Purchase processes.  
  
Create a G/L account in the Asset category called "Purchase Tax Clearing account." This account 
will be used for expense purposes related to the integration.  
  
The screenshot below shows the setup of the Purchase Tax Clearing account.  

Freight - Setup

Name Revenue Account Expense Account Output Tax GroupInput Tax GroupFixed ...
1 Freight Charges 445710

TR_iVAT 445660 445710

TR_oVAT 445660 445710

OK Cancel

 

    

   
   
   

 



 

  
  
For VAT countries, the following authority levels are defined.  
  

Tax Account Description 
TR_iVAT G/L account where the city authority tax amount will be posted to under 

the Expense Account setup.  

   
By setting up the G/L accounts as described above, you can ensure that the tax amounts collected 
for each authority in the processes are accurately recorded as revenue. Expenses related to these 
tax amounts will be recorded in the "Purchase Tax Clearing Account."   

Additional G/L setup for Vendor Charged Tax Process   

The configuration of general ledger settings is not required for the Vendor VCT process. By enabling 
this process in Determination, your integration will seamlessly support the Hold-Payment method for 
Vendor VCT. 

Master Data Maintenance 

This section lists the required master data that needs to be configured in your SAP Business One 
client. 

Customer Addresses (Ship-To) for Sales 

Addresses are important elements to determine the tax for shipping goods from one location to 
another location. In this solution, ship-to addresses are defined in the customer master.  
 
To define the ship-to addresses, go to Business Partner Master Data > Addresses tab. Select 
address type Ship-To, and click on Define New. 
 

File Edit View Data GoTo ModulesTools Window Help TRUS|manager

ÿ

x

13600000 0100101 Level 10
Name Purchase TaxClearingAccount(Assets Assets

CurrentAssets-CurrentAssets
G/LAccount Details Cashand Equiv-Cash andCashEquivalents

Title Active Accqunt Receivables-Receivables Liabilities
External Code 12100000-01-001-01-AccountsReceivable-Domestic(HO,USA,GA)
Currency AllCurrencies 12200000-01-001-01-AccountsReceivable-ForeignÿHO,USA,GAÿ Equity
Confidential Level 4 12400000-01-001-01-Allowance forDoubtful DebtsÿHO,USA,GA)

12500000-01-001-01-InterestReceivableÿHO,USA,GA)
Balance -47.50 12510000-01-001-01-OtherReceivablesÿHO,USA,GA)

G/LAccount Properties 12540000-01-001-01-TravelExpenses-AdvancesÿHO,USA,GA)

Account Type Other Inventory-Inventory
13100000-01-001-01-Inventory-RawMaterialÿHO,USA,GA) Cost of Sales

Control Account
BlockManual Posting 13200000-01-001-01-Inventory-Work InProgressÿHO,USA,GAÿÿ

CashAccount Expenses
Beval.(Currency) 13400000-01-001-01-Inventory-FinishedGoodsÿHO,USA,GA)

13500000-01-001-01-Inventory-Returms(HO,USA,GA)
13900000-01-001-01-GoodsClearing Account(HO,USA,GA) FinancingCash Flow Relevant Other Current-Other CurrentAssets

Relevant forCostAccounting
14100000-01-001-01-Prepaid ExpensesÿHO,USA,GA)
14200000-01-001-01-PrepaidTaxesÿHO,USA,GA) Other Revenues a.

Project 15100000-01-001-01-LoansReceivable-Short TermÿHO,USA,GA)
15200000-01-001-01-Accrued Expenses-Short TermÿHO,USA,GA) #9
13600000-01-001-01-PurchaseTaxClearingAccount(HO,USA,GA)

Fixed Assets-Fixed Assets
Cost-Cost #10

16100000-01-001-01-Land&LandImprovementsÿHO,USA,GA)

06/01/23 SAP Bnn3:19PM

         

 

 

    
    

   
    

  
    

    
 

   
 

 
 

 
  

   
  

  
 

    

 
 

 
  

   
 

  
 

 



 

 
 
 

Enter the Address ID. Under the Country/ Region field, by default, this information will be populated 
per the country localization settings. You may change this information if required. 
 
Enter the address details like state, county, city, Zip code/Postal Code, Geo Code etc.  
Save the address.  
 

Customer Registration Number 

 
Please include your Customer VAT registration number, as it is a mandatory requirement for VAT. 
Input the VAT registration number in the designated field Federal Tax ID on the screen below. 
 

 
 
 

Business Partner Master Data

Customer CUS0001 Customer Local Currency
Name Paris, FR Account Balance ÿ 5,455.00
Foreign Name Deliveries 0.00
Group Customers s ÿ 10,400.00
Currency All Currencies Opportunities
Federal Tax ID FR09417760156

Checks

General Contact PersonsAddresses Payment TermsPayment Run Accgunting saadoids Remarks Attachments

Bill To Ship To Show Location in Web Browser
Define New Address ID
Ship To Address Name 2
Paris Address Name 3
Define New Street / PO Box

Block
City

County
State
Country/Region France
Federal Tax ID FR09417760156

tneyao se pa5 Street No.

BusinessPartner MasterData

Code Customer CUS0001 Customer Local Currency
Name Paris, FR Account Balance 19,669.02

Foreign Name Deliveries 0.00

Group Customers 9,400.00
Currency AllCurrencies Opportunities
Federal Tax ID FR09417760156

Checks

General Contact Persons Addresses s Payment Run Accounting Properties Remarks Attachments

Tel 1 Contact Person

Mobile Phone UnifiedFederalTaxID FR09417760155

Fax

 

    
     

   
     

   
  

 

         

   

  
  

  
  

 
 

 
 

  
  

 

 

     
    

   
   

   
  

 

         

  

   



 

Delivery Terms (Incoterms) 

Enter the incoterms (delivery terms) in the logistic Tab under sales documents. Standard delivery 
terms are automatically predefined on the sales documents.  
 

 
 

Vendor/Supplier Addresses (Ship-From) for Purchase 

Addresses are important elements to determine the tax for shipping goods from one location to 
another location. In this solution, ship-from addresses are defined in the supplier/vendor master.  
 
To define the ship-from addresses, go to Business Partner Master Data > Addresses tab. Select 
address type Ship-To, and click on Define New and enter the Ship From address name and other 
details like State, city, Zip code, GLN (geo location no/County no) etc. Multiple ship-from addresses 
can be entered. 
 

A/R Invoice

Customer CUS0001
Name Paris, FR
Contact Person ÿ

Customer Ref. No. test
BP Currency USD 0.983400

Contents Logistics Acc

Ship To PARIS

Paris

Bill To

Shipping Type
Delivery Term DDP

 

  
  

  

  
   

   

  

 

 

 
 



 

 
 
During the order creation process, the Ship-From field on the logistics tab will be available for 
selection. This customized field will come automatically when you install the Thomson Reuters 
integration package.  
 

  

Business Partner Master Data

Code Supplier SUP00001 Vendor Local Currency
Name Supplier 1 Account Balance -1,000.00
Foreign Name Goods Receipt POs 0.00
Group Vendors Purchase Orders -8,655.00
Currency All Currencies
Federal Tax ID FR09417760155

GeneralContact PersonsAddressesPayment TermsPayment RunAccgunting saadoid Remarks Attachments

Pay To Ship To Show Location in Web Browser
Define New Address ID Ship From - Paris
Ship To Address Name 2
Ship From - Paris Address Name 3
Define New Street / PO Box

Block
City Paris
Zip Code
County
State
Country/Region France

Hneyad se a5
Federal Tax ID FR09417760155
Street No.

 

     
    

   
    

  
  

        

   
   

  
  

  
 

  
 
 

 
  

 
  



 

Warehouse Addresses (Ship-From/Ship to) and Registration Numbers 

The Ship-From and Ship-To address is an important element for tax determination to indicate 
shipping of goods from the seller’s warehouse to the Buyer’s ship-to location. Warehouse address 
can play both roll as ship from (in case of Sale) as well as ship to (in case of Purchase).   
 
In SAP Business One, the company address is managed in the company master as the registered 
address. However, warehouse locations may differ from this based on the warehouse used during 
the sales and purchase transaction. 
 
To ascertain the correct tax, both the buyer and seller must have a registration number. In the 
warehouse master, users are required to input the tax registration number in the Federal Tax ID 
field. During sales transactions, this registration number serves as the seller's role, while in 
purchases, it functions as the buyer's role. Additionally, the supplier's registration number is utilized 
as the seller's role in the context of a purchase transaction. 
 
To maintain the warehouse address and tax registration numbers, go to Administration > Setup > 
Inventory > Warehouses. 
 
Enter the required address fields e.g., Country, State, County, City, Zip Code, Geo Code etc. and 
VAT Registration number in the Federal Tax Id field. 
 

 
  

Warehouses-(Default) - Setup
Warehouse Code 01 Warehouse Name Paris

General Accounting

Inactive ]Drgp-Ship

Location Nettable

Consignment Business Partner

Street/PO Box
Street No. Enable Bin Locations

apo diz
City Paris
County
Country/Region France
State
Federal Tax ID FR801161988B01

GLN Show Location in Web Browser
Tax Office
Address Name 2
Address Name 3

OK Cancel

 

    

  

  

  

 

 
  

 
  

 
  

 
  

  
 

 
 

 



 

Additional Supported Functionality 
User Element Attributes  

For this integration we have provided the ability to send an additional 40 User Defined Fields (UDFs) 
to ONESOURCE Determination for complex tax determination cases. These additional fields are 
mapped to ONESOURCE Determination as Custom Attributes at both the Invoice and Line Level. 
This configuration is optional. 
 
Depending on your tax requirements, you have the ability to map and send up to 50 additional field. 
Here, you will be able to utilize any fields available within the SAP Marketing Document fields or set 
default values.  
 
In this example below, a new custom Marketing Document field is created to represent the 
“Distribution Channel.” 
 
Note: You may create new custom field via the Menu Tools> Customization Tools> User Defined 
Fields – Management under the category Marketing Documents.  
 
To map the fields or default values to the Header or Line Level attributes, navigate to the TR 
Configuration Screens (Modules > Administration> Setup> TR Configuration> Header attribute or 
Line Attribute tab) 
 
In the example below, a new custom field has been created to capture the distribution channel for 
the sales transaction. This is map to Header level User Attribute 1 under the column SAP UDFs. 
Alternatively, if you may send fixed or default values to ONESOURCE Determination in the attributes 
by defining the mapping under the column Static/Default Value  
  



 

 

Product Tax Category 

Product Tax Category is an important element for tax determination as it categorizes a group of 
items or products having different taxability treatment. This Integration supports either categorization 
by Commodity Codes or Product Codes. 

Commodity Codes 

Maintain Commodity Codes under the field Commodity Classification within the Item Master Data  
 

TR Configuration x

Company Info Header Attribute Line Attribute Other Settings
# TR Attributes SAP UDFs  Static/Default Value

Attribute01 U_DChannel
2 Attribute02 CIF
m Attribute03
4 Attribute04
5 Attribute05
6 Attribute06
7 Attribute07
8 Attribute08
9 Attribute09
10 Attribute10
11 Attribute11
12 Attribute12
13 Attribute13

14 Attribute14
15 Attribute15
16 Attribute16
17 Attribute17

OK Cancel

  

    

    
  

   
  

  
  

  

  
  

  

  

  

  
  
  
  
  

  

 



 

 
 

Product Code Mapping 

 
Various options are provided within this integration for Product Code Mapping. 
Navigate to the TR Configuration menu. From the Main Menu, go to Administration> Setup> TR 
Configuration > Other Settings> Product Code. 
Here you will select which field on the Item Master Data should be mapped to the Product Code field 
for tax determination. 
 

Item Master Data ÿx

Item No. Manual 00110 Inventory Item
Description Item No1 With Product Code and commotidiSales Item 
Foreign Name Purchasing Item
Item Type Itemis
Item Group Items
UoM Group Manual ÿ Bar Code
 Price List Price List 01 Unit PricePrimary Curre

General Purchasing DataSales Data Inventory Data Planning Data Production DataProperties Remarks Attachments 

 Tax Liable

 Do Not Apply Discount Groups
 Manufacturer  No Manufacturer -
Additional Identifier
 Shipping Type
Serial and Batch Numbers
Aq walI abeue None

O Active From Remarks

 Inactive
O Advanced

Country/Region of OriginUSA

Commodity Classification02

OK Cancel

  

    
  

  
  
  

    
   

     

 

 
 

 
 

 
  

   
 

 

  

  

 



 

 
 

There are four options to map the product code as follows: 

 
Field Description 

Item Code This is the item code of the material.  

Item group An item group also can be mapped as product code 

Standard Item Identification Items standard identification also can be set as product 
code. 

Item User Defined field User can also use UDF to determine the product code. 

 
 

 
 

Freight and Delivery Costs  

TR Configuration

Company Info Header Attribute Line Attribute Other Settings

Product Code Item Code

Item Code
2 Item Group
3 Standard Item

UDF Value

Item Master Data

Item No. ManualIITM00005 Inventory Item Product Code L00024
Description Item No2 With Commodity  Sales Item
Foreiqn Name
Item Type Items
Item Group Items
UoM Group Manual Bar Code
Price List Price List 01 Unit Price Primary Curr

GeneralPurchasing Data Sales DataInventory DataPlanning DataProduction DataPropertiesRemarksAttachments

 Tax Liable

Do Not Apply Discount Groups
Manufacturer - No Manufacturer -
Additional Identifier
Shipping Type
Serial and Batch Numbers
 Manage Item by None

Country/Region of Origin USA
Standard Item Identification8471.30
Commodity Classification 78.100

OK Cancel

 

    

  

 

  

  

 

     

   
 

  
  
   

    

      

 

 
  

 
 

 
  

  
  

  

 



 

Within the integration with ONESOURCE Determination, tax determination is supported for freight 
lines entered within sales or purchase documents in SAP Business One. Freight charges can be 
added at either the document level or the line level, providing flexibility in capturing freight-related 
expenses. 
 
To add freight charges at the document level: 
 

1. Open the sales or purchase document (e.g., sales order, sales invoice, purchase order, etc.) 
in SAP Business One. 

2. Locate the freight-related field or section within the document header, which allows you to 
enter the freight charges. 

3. Enter the appropriate freight amount or percentage in the designated field. 

4. Save the document. The integration will consider the freight charges entered at the 
document level for tax determination. 

5. To add freight charges at the line level: 

6. Open the sales or purchase document (e.g., sales order, sales invoice, purchase order, etc.) 
in SAP Business One. 

7. Navigate to the line-item section of the document. 

8. Select the desired line item where you want to add freight charges. 

9. Within the line item details, locate the field or column dedicated to capturing freight charges. 

10. Enter the applicable freight amount or percentage for the specific line item. 

11. Save the document. The integration will consider the freight charges entered at the line-item 
level for tax determination. 

 
By supporting tax determination on freight lines, the integration enables accurate calculation and 
application of taxes on freight-related expenses within sales or purchase transactions. This ensures 
compliance with tax regulations and provides visibility into the tax implications of freight charges. 
 

 
 

A/R Invoice

Customer CUS0001
Name Paris, FR
Contact Person
Customer Ref. No.
BP Currency EUR

Contents Logistics Accounting Attachments

Item/Service Type Item
ÿ Item No. Item DescriptionQuantity Unit Price Discount % oxe Total (LC) Freight 1 Freight 1 (LC)Freight 1 Tax ...UoM Code COGS Distr. Rule

ITM00001 Item 1 1 1,000.00000 EUR 0.00ONA 1,000.00 EUR Freight Charg100.00 EURONA EACH
0.00ONA

Freight Charges
TR_iVAT
TR_oVAT
Define New

 

  
  

 
 

  

    

  

             

         
 

 
 
 



 

The following freight scenarios are explained below: 

Freight at line level  

When freight is entered at the line level, it is assessed based on the product code or commodity 
code sent with the line item.  

If freight charges are applied to line items, the system will examine the product code or commodity 
code associated with the charges and calculate the applicable taxes based on predefined rules. 
Users will be able to view the tax details corresponding to each line item, providing clear visibility into 
how taxes are calculated. 

Freight at header level 

Freight charges or any other charges can be applied at document level, and be distributed based on 
distribution methods such as: 

• Quantity 

• Volume 

• Weight 

• Equally 

• Row Total 

 
In this solution, we also handle scenarios where taxes need to be calculated based on distributed 
values. If a distribution rule is selected, the respective tax will be calculated accordingly. However, if 
no distribution rule is chosen, the charges line items will be treated as separate line items for tax 
calculation purposes. The details of the tax calculation will be displayed in the Freight table. 
 



 

 

To set up the product code mapping for freight, go to Modules> Administration> Setup> General> 
Freight. 

 

Vendor Charged Tax and Postings 

This integration now supports patrial the Vendor Charged Tax Verification functionalities of 
ONESOURCE Determination. This section explains the solution and related configuration to support 
VCT-V and related postings.  

 

Vendor Charged Tax Processes 

Refer to the Vendor Charged Tax documentation on the Thomson Reuters Help Centre for more 
information on the Vendor Charged Tax Verification functionalities of ONESOURCE Determination. 
 
 

1. Ship-From Address Selection for Purchase Process: 
• In this solution, the ship-from address for the purchase process is determined using a 

User Defined Field (UDF) in the logistics tab of the Purchase order by selecting the 
address id from the Supplier master. If there are multiple addresses maintained for 
the Supplier Master, user will be able to select the appropriate address.  
 

Freight - Setup

Name Revenue Account Expense Account Output Tax GroupInput Tax GroupFixed ...
1 Freight Charges 445710

TR_iVAT 445660 445710

TR_oVAT 445660 445710

OK Cancel

 

    

   
   
   

 



 

 
 

• By default, the system will automatically select the first ship-from address available 
for the vendor. 

• If there are multiple ship-from addresses defined for a vendor, the user will need to 
manually select the appropriate address during the purchase process. 

 
 

2. Vendor's Charge Tax (VCT) in A/P Invoice: 
 

• Vendor's Charge Tax (VCT) is applicable only in A/P (Accounts Payable) invoices 
and the "Hold the Payment" accrual method is the only applicable option in VAT 
countries. 
 

• If VCT is configured in the tax determination process, the system will validate the 
VCT amount and the calculated tax amount. 

• If there is a difference between the VCT amount charged by the vendor and the 
calculated tax amount determined by ONESOURCE, the system will not allow the 
user to post the transaction. 

• This ensures that the tax amounts are accurately calculated and aligned with the tax 
determination results. 

ERP Tax Code Line-Item Wise Break up  

There is an additional TAB is introduced in marketing documents (Quotation, order, invoice, and 
Return) called Tax Details. In this Tab system will show all the ERP tax code along with some more 
information against each line items. It will help user to easily identify the tax break up if there is 
multiple tax code is applied against a single line item. 
 

Business Partner Master Data

Code Supplier SUP00001 Vendor Local Currency
Name Supplier 1 Account Balance -1,000.00
Foreign Name Goods Receipt POs 0.00
Group Vendors Purchase Orders -8,655.00
Currency All Currencies
Federal Tax ID FR09417760155

GeneralContact PersonsAddressesPayment TermsPayment RunAccgunting saadoid Remarks Attachments

Pay To Ship To Show Location in Web Browser
Define New Address ID Ship From - Paris
Ship To Address Name 2
Ship From - Paris Address Name 3
Define New Street / PO Box

Block
City Paris
Zip Code
County
State
Country/Region France

Hneyad se a5
Federal Tax ID FR09417760155
Street No.

 

 

     
    

   
    

  
  

        

   
   

  
  

  
 

  
 
 

 
  

 
  



 

Tax Details Info. 

In the tax details tab the below mentioned details will be maintained. Once the tax call will be 
completed then system will automatically fill the tax details along with be below mentioned details. 
 

Field Description 

Line ID 
This is the line items line id, which will represent the line 
items details 

Item Code 
Item code will help to identify the applicable tax against 
each item, there might be same item applied in multiple 
rows that's why the line id and item code will be applied  

IDT Tax Code IDT tax code is ERP tax code, which will be automatically 
get from the tax engine after each tax call 

Base Amount User can also use UDF to determine the product code. 

Tax Rate Tax rate will be fetched from tax rule engine 

Tax Amount As per the predefined tax rule system will give the tax 
amount. 

Direction There will be two types of direction as O and I. 

Authority There might be different type of tax authority in a 
transaction. 

 

 

Invoicing and Commit Calls 
The tax calculation process remains the same for all the documents, including sales quotation, sales 
order, A/R invoice, A/R credit note, purchase quotation, purchase order, A/P invoice, and A/P credit 
memo. However, during the financial posting of invoices or credit documents, a commit call is 
triggered to save the tax information to the TR Audit or report database. 
 
The commit call ensures that the tax information is securely and accurately stored in the reporting 
database for further analysis and reporting purposes. Without the commit call, the tax information will 
not be saved in the reporting database, and it may not be available for generating reports or 
conducting analysis on tax-related data. 
 
By triggering the commit call, the system ensures that the tax information is properly recorded and 
can be accessed when needed for auditing, compliance, or analysis purposes. This allows users to 

Contents Logistics Accounting Attachments Tax Details

LineId Item Code IDT Tax Code Base Amount Tax Rate Tax Amount Direction Authority

1 1 ITM00001 A1-MVS 5,600.00 0.20 1,120.00 TVA

     

        

       



 

have a comprehensive view of the tax-related transactions and enables them to generate reports or 
perform analysis based on the saved tax information in the reporting database. 

 

Logging and Monitoring  
Using the Unified Logging Feature  

To access the logging feature in ONESOURCE Determination, follow these steps: 
 

1. Login to ONESOURCE Determination. 

2. Click on "Tools" in the menu. 

3. Select "Tax Tools" from the dropdown menu. 

4. Choose "Unified Logging" from the options. 

 
To find the relevant logs, use the Correlation Id displayed on the SAP Business One screen. The 
Correlation Id is a unique identifier that helps you locate specific logs.  
 
On the Unified Logging page in ONESOURCE Determination, you can find logs related to the SAP 
Business One Integration for Tax API. These logs contain information about the input and output 
data exchanged between ONESOURCE Determination and SAP Business One. 
Additionally, you can also access logs related to the Determination process itself. These logs provide 
details about the input data sent to ONESOURCE Determination for tax calculation and the 
corresponding output results. 
 
By reviewing these logs, you can gain insights into the data flowing between ONESOURCE 
Determination and SAP Business One, as well as the tax determination results. This information can 
be valuable for troubleshooting, analysis, and auditing purposes. 
 

File Edit View Data GoTo Modules Tools Window Help TRTEST|manager

A/PInvoice

ItemNo1WithProductC.5 $7.50 0.000 N/A $37.50 w...
3 FREIGHTFreight $8.19 0.000 N/A $8.19 ÿ w...

3uyer -NoSalesEmployee- Total BeforeDiscount$215.69
Owner Discount %
raxAmount 14.71 TotalDownPayment
CorrelationId 141_20230228094028 PurchaseTaxFreight $14.71
lendorTaxAmount 14.71 Rounding

Tax
PaymentOrderRun Total PaymentDue $230.40

Remarks AppliedAmount
Balance Due $230.40

          

 

      
         

    
   

   
    

   
 

   
  

 



 

 

API Request Log file 

In this integration whenever a tax call will happen, system will generate a tax call request log in the 
add-on folder with the respective information which will be consumed by the tax engine and based 
on the details system will calculate the tax and return the result. But if there is any information is 
missing in the document then system may show an error like “API error,” it means there is no 
specific error was found by the tax engine but there is something wrong. So, user can check the 
request log and easily find out the missing information. User can find the log folder in below path 
 
“C:\Program Files\SAP\SAP Business One\AddOns\Thomson Retures\TRC indirect Tax Utility – 
1.2.0.0\X64Client\LogFiles” 
 
This log file can be auto deleted as per user needs. By deafult there will be no delete applied, but if 
user wants system should keep log files for certain period say last 10 days, then user needs to apply 
the days is the application config files using the below path 
“C:\Program Files\SAP\SAP Business One\AddOns\Thomson Retures\TRC indirect Tax Utility – 
1.2.0.0\X64Client\” and select the config file “VAT_Calculation.exe.config” and right click on the file 
and select “open with note pad” and change the “daysOld” value 0 to 10 (0 will be default). 
 
 

THOMSONREUTERS Chandra Tangudu
INDIRECTTAX TENANTIndirectTaxIntegrationsSAT(VGDÿ

Dashboard Companies Configuration Exemption Certificate Tools Reports&Analytics Help

Unified Logging

externalCompanyld:"INTSAPDEV_USBusinessOne" KQL ~3monthsago now CRefresh

correlationld:139_20230323183202x +Addfilter

21documents

Time content loggingSystem contentType externalCompanyld contentld correlationld traceld

Mar24,2023@00:02:03.000 {"companyRol determination Request Payload INTSAPDEV_USBusinessOne 139_202303231832

e":"s","externalcomp 02
anyId":"INTSAPDEV_US
Businessone","invoic
e":[{"calculationDir
ection":"F","currenc
vCode":"UsD"."invoic

Mar24,2023@00:02:03.000 {"companyRol tax-api ResponsePayloadINTSAPDEV_USBusinessOne 139_202303231832
e":"s","externalcomp 02
anyId":"INTSAPDEV_US
Businessone","statu
s":{"isSuccess":tru
e,"isPartialSucces
s":true}."document

Mar24 2023@99.02.0309 TavEin determinatinn Tay R1nck Meccan TNTSAPDEVlISRusinessOne 139 292393231832

 

  
  

       

 

     

  

 

        

      
  
 

 
 
 

 

      
  
 

 
 

 
 

      



 

 
 
Please note that the specific steps and user interface may vary depending on the version and 
configuration of your SAP Business One system. It is always recommended to consult the official 
documentation or reach out to your system administrator for detailed guidance on performing these 
actions within your specific setup. 

Monitoring Reports  

To monitor invoices processed with tax calculated from ONESOURCE Determination, users can 
access the Document Draft Reports in the SAP Business One Reports module. Here is how: 
 

1. Click on the "Reports" menu in SAP Business One. 

2. Navigate to the "Sales and Purchasing" section. 

3. Select the "Document Drafts Report" option. 

 
By running this report, users will be able to view a list of document drafts, including invoices, which 
have been generated with tax calculations performed by ONESOURCE Determination. This report 
provides valuable information for tracking and reviewing invoices before they are finalized and 
posted. 
 

VAT_Calculation.exe.config -Notepad

FileEdit FormatViewHelp
<?xmlversion="1.0"encoding="utf-8"?>
<configuration>

<appSettings>
<add key="days0ld" value="10" />

</appSettings>
<runtime>

<assemblyBinding xmlns="urn:schemas-microsoft-com:asm.v1">
<dependentAssembly>

<assemblyIdentity name="System.Runtime.CompilerServices.Unsafe" publicKey
/>

<bindingRedirect oldVersion="0.0.0.0-6.0.0.0" newVersion="6.0.0.0" />
</dependentAssembly>

</assemblyBinding>
</runtime>

</configuration>

 

 
 

 
 

 
 

 
 

 
 

 
 

 
 

 



 

 
 
To review the drafted reports with tax amounts in the SAP Business One Document Drafts  
 
Report, follow these steps: 
 

1. Click on the "Document Drafts Report" option in the SAP Business One Reports menu. 

2. In the report parameters or selection screen, select the functional area for which you want to 
review the draft reports. This could be either sales or purchasing, depending on your 
requirements. 

 
By selecting the functional area, the Document Drafts Report will filter and display the relevant draft 
reports for the chosen area, including the tax amounts calculated by ONESOURCE Determination. 
This allows users to review the draft documents, verify the tax calculations, and make any necessary 
adjustments before finalizing the invoices or purchase orders. 

File Edit view Data GoTo Modules Tools Window Help ikicoiImdndyer

d Search Search by Template
Production

MRP

Service

RHumanResources

Reports

Financials

CRM

Opportunities

SalesandPurchasing

OpenItemsList

DocumentDraftsReport

Backorder

SalesAnalysis

PurchaseAnalysis

          

   
 

 

 

 

 

 

 

 

 

 

 

 

 



 

 
Click on OK button to see all drafts report with tax amount.  
 

 

ÿ
DocumentDraftsReport-SelectionCriteria

User manager Open Only

Date

Sales-A/R Purchasing - A/P

Sales Quotations Purchase Request
Sales Orders Purchase Quotation
Deliveries Purchase Orders
Return Request Goods ReceiptPO

Returns Goods Return Request
A/RDownPayment Goods Return
A/RInvoices A/PDownPayment
A/RCreditMemos A/PInvoices

A/PCreditMemos

Inventory InventoryCountingTransactions

Goods Receipt Inventory Counting
Goods Issue InventoryOpening Balances
Inventory Transfer Request Inventory Posting
InventoryTransfers M

OK Cancel

DocumentDraft

DraftNoDocument Document No.Posting Date Total Total Tax VendorTaxAmo

3 A/PInvoices 32 01/16/23 $12,990.00 990.00 800.00

5 A/PInvoices 52 01/25/23 $12,500.00 866.25 700.00
7 A/PInvoices 70 02/13/23 $14,072.50 1,072.50 500.00
8 A/PInvoices 72 02/15/23 $ 12,990.00 990.00 600.00

9 A/PInvoices 73 02/21/23 $114.10 9.10 0.00

OK Cancel

 
 

   

 

  

  
  

  
  

  
  

  
  

 

  

  
  

  
  

 

 

     

       
       

       

       

       

 



 

  

Data Mapping 
Sales Process 

Request Payload Mapping Fields  

ONESOURCE REST API Fields Business ONE 
Fields Transformation/ Description 

Header.externalCompanyId U_INTID When the user clicks on the 'Calculate 
Tax' button in the SAP document, the 
system retrieves the external company 
ID from the TR config file. 
Subsequently, it sends this ID, along 
with the secret key, to the REST API 
for validation. Upon successful 
validation, a token is generated and 
verified, enabling further processing.  

Header.companyRole   if the transaction type is Sales 
(Objtype in (13,14,17,19)) then 
CompanyRole="S" and when 
transaction type is Purchase (ObjType 
in (22,23,18,19)) then 
CompanyRole='B'   

Documents.Address.type OINV.ShiToCode Where Header.adderssType='ST' set 
Type= ‘shipTo’ 

Documents.Address.country OINV.CountryS Where Header.adderssType='ST' 

Documents.Address.region OINV.StateS Where Header.adderssType='ST' 
Documents.Address.City OINV.CityS Where Header.adderssType='ST' 
Documents.Address.county OINV.CountyS Where Header.adderssType='ST' 
Documents.Address.postcode OINV.ZipCodeS Where Header.adderssType='ST' 
Documents.Address.geocode OINV.GlbLocNumS Where Header.adderssType='ST' 
Documents.Address.Type OWHS.ShiToCode Where Line.adderssType='SF' set 

Type= ‘shipFrom’ 
Documents.Address.country OWHS.CountryS Where Line.addressType='SF' 
Documents.Address.region OWHS.StateS Where Line.addressType='SF' 
Documents.Address.City OWHS.CityS Where Line.addressType='SF' 
Documents.Address.county OWHS.CountyS Where Line.addressType='SF' 
Documents.Address.postcode OWHS.ZipCodeS Where Line.addressType='SF' 
Documents.Address.geocode OWHS.GlbLocNumS Where Line.addressType='SF' 
Documents.Currency OINV.DocCur   
Documents.documentDate OINV.DocDate   
Documents.Line.lineNumber INV1.LineNum   
Documents.Line.productCode INV1.StdItemId   



 

Documents.Line.commodityCode INV1.CommClass   
Documents.Line.quantities INV1.Quantity   
Documents.Line.taxableBasis INV1.LineTotal   
Document.registrations.type  sellerRoll 
Document.registrations.registrationNumber OWHS.FedTaxId 

OADM.TaxIdNum, 
OADM.TaxIdNum2, 
OADM.TaxIdNum3, 

sellerRegistration No 

Document.registrations.type  buyerRoll 
Document.registrations.registrationNumber OCRD.VatIdUnCmp, 

OCRD.LicTradNum 
buyerRegistration No 

Document.deliveryTerm.type  incoterms 
Document.deliveryTerms.term OINV_TERM As per standard 

Response Payload Mapping Fields 

ONESOURCE REST API Fields Business ONE 
Fields Transformation/ Description 

Header.externalCompanyId TR_CONF1.U_INTI
D 

External company id is obtained from 
TR configuration screens and sent to 
REST API along with secret id/ key, 
which will be validated for further 
processing 

Header.companyRole   if the transaction type is Sales (Objtype 
in (13,14,17,19)) then 
CompanyRole="S" and when 
transaction type is Purchase (ObjType 
in (22,23,18,19)) then 
CompanyRole='B'   

documents.companyName TR_CONF1.CMNA
ME 

  

documents.companyRole   if the transaction type is Sales (Objtype 
in (13,14,17,19)) then 
CompanyRole="S" and when 
transaction type is Purchase (ObjType 
in (22,23,18,19)) then 
CompanyRole='B'   

Documents.currencyCode OINV.DocCur   
Documents.externalCompanyId TR_CONF1.CMNA

ME 
  

Documents.transactionDate OINV.DocDate   
Documents.totalTaxAmount OINV.U_TAXAMT   
documents.callingSystemNumber TR_CONF1.U_INTI

D 
  

documents.hostName OADM.HostName   
documents.fiscalDate OPCH.DocDate   
documents.documentNumber OINV.DocNumber   

 

 

 

 



 

documents.uniqueDocumentNumber TR_CONF1.U_INTI
D + 
OINV.DocNumber 
+ companyRole + 
YEAR 

  

Documents.Line.lineNumber INV1.LineNum   
Documents.Line.grossAmount INV1.LineTotal   
Documents.Line.taxsummary.taxableBasi
s 

INV1.LineTotal   

Documents.Line.taxsummary.nonTaxable
Basis 

  As per commoditycode or product code 

Documents.Line.taxsummary.exemptAmo
unt 

  As per commoditycode or product code 

Documents.Line.taxsummary.taxRate INV1.U_R As per effectiveZone 
Documents.Line.taxsummary.effectiveTax
Rate 

INV1.U_R As per effectiveZone 

Documents.Line.transactionType OINV.DocType GS Default 
Documents.Line.totalTaxAmount OINV.U_TAXAMT   
Documents.Line.taxes.responseSummary   As per ship to and ship from Address 

and rule defined in TR Tax Engine 
Documents.Line.taxes.adminZoneLevel   As per ship to and ship from Address 

and rule defined in TR Tax Engine 
Documents.Line.taxes.authorityType   As per ship to and ship from Address 

and rule defined in TR Tax Engine 
Documents.Line.taxes.authorityCurrency
Code 

OINV.DocCur   

Documents.Line.taxes.effectiveZoneLevel   As per ship to and ship from Address 
and rule defined in TR Tax Engine 

Documents.Line.taxes.erpTaxCode   As per ship to and ship from Address 
and rule defined in TR Tax Engine 

Documents.Line.taxes.exemptAmount.aut
horityAmount 

  As per ship to and ship from Address 
and rule defined in TR Tax Engine 

Documents.Line.taxes.exemptAmount.do
cumentAmount 

  As per ship to and ship from Address 
and rule defined in TR Tax Engine 

Documents.Line.taxes.grossAmountautho
rityAmount 

  As per ship to and ship from Address 
and rule defined in TR Tax Engine 

Documents.Line.taxes.documentDescripti
on 

  As per ship to and ship from Address 
and rule defined in TR Tax Engine 

Documents.Line.taxes.jurisdictionText   As per ship to and ship from Address 
and rule defined in TR Tax Engine 

Documents.Line.taxes.nonTaxableBasis.a
uthorityAmount 

  As per ship to and ship from Address 
and rule defined in TR Tax Engine 

Documents.Line.taxes.nonTaxableBasis.d
ocumentAmount 

  As per ship to and ship from Address 
and rule defined in TR Tax Engine 

Documents.Line.taxes.taxAmount.authorit
yAmount 

  As per ship to and ship from Address 
and rule defined in TR Tax Engine 

Documents.Line.taxes.taxAmount.docum
entAmount 

  As per ship to and ship from Address 
and rule defined in TR Tax Engine 

Documents.Line.taxes.taxRate   As per ship to and ship from Address 
and rule defined in TR Tax Engine 

Documents.Line.taxes.taxRateCode   As per ship to and ship from Address 
and rule defined in TR Tax Engine 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

Documents.Line.taxes.taxableBasis.autho
rityAmount 

  As per ship to and ship from Address 
and rule defined in TR Tax Engine 

Documents.Line.taxes.taxableBasis.docu
mentAmount 

  As per ship to and ship from Address 
and rule defined in TR Tax Engine 

Documents.Line.taxes.taxableCountry   As per ship to and ship from Address 
and rule defined in TR Tax Engine 

Documents.Line.taxes.addressType   As per ship to and ship from Address 
and rule defined in TR Tax Engine 

Documents.Line.taxes.authorityName   As per ship to and ship from Address 
and rule defined in TR Tax Engine 

Documents.Line.taxes.authorityUuid   As per ship to and ship from Address 
and rule defined in TR Tax Engine 

Documents.Line.taxes.euTransaction   As per ship to and ship from Address 
and rule defined in TR Tax Engine 

Documents.Line.taxes.natureOfTax   As per ship to and ship from Address 
and rule defined in TR Tax Engine 

Documents.Line.taxes.ruleOrder   As per ship to and ship from Address 
and rule defined in TR Tax Engine 

Documents.Line.taxes.taxDeterminationD
ate 

OINV.DocDate As per ship to and ship from Address 
and rule defined in TR Tax Engine 

Documents.Line.taxes.taxPointDate OINV.DocDate As per ship to and ship from Address 
and rule defined in TR Tax Engine 

Documents.Line.taxes.taxType   As per ship to and ship from Address 
and rule defined in TR Tax Engine 

Documents.Line.taxes.taxableRegion   As per ship to and ship from Address 
and rule defined in TR Tax Engine 

Documents.Line.taxes.taxableCounty   As per ship to and ship from Address 
and rule defined in TR Tax Engine 

Documents.Line.taxes.taxableCity   As per ship to and ship from Address 
and rule defined in TR Tax Engine 

Documents.Line.taxes.taxableGeocode   As per ship to and ship from Address 
and rule defined in TR Tax Engine 

Documents.Line.taxes.taxablePostcode   As per ship to and ship from Address 
and rule defined in TR Tax Engine 

Documents.Line.taxes.zoneName   As per ship to and ship from Address 
and rule defined in TR Tax Engine 

Documents.Line.taxes.zoneLevel   As per ship to and ship from Address 
and rule defined in TR Tax Engine 

Documents.Line.taxes.ZoneFipsCode   As per ship to and ship from Address 
and rule defined in TR Tax Engine 

Documents.Line.quantities.amount INV1.Quantity   
Documents.Line.quantities.uom INV1.unitMsr   
Document.registrations.type  sellerRoll 
Document.registrations.registrationNumbe
r 

OWHS.FedTaxId 
OADM.TaxIdNum, 
OADM.TaxIdNum2, 
OADM.TaxIdNum3, 

sellerRegistration No 

Document.registrations.type  buyerRoll 
Document.registrations.registrationNumbe
r 

OCRD.VatIdUnCm
p, 
OCRD.LicTradNum 

buyerRegistration No 

Document.deliveryTerm.type  incoterms 
Document.deliveryTerms.term OINV_TERM As per standard 

 

 

 

 

  



 

 

Purchasing Process 

Request Payload Mapping Fields 

ONESOURCE REST API 
Fields 

Business ONE 
Fields 

Transformation/ Description 

Header.externalCompanyId U_INTID External company id is obtained from 
TR configuration screens and sent to 
REST API along with secret id/ key, 
which will be validated for further 
processing 
 

Header.companyRole   if the transaction type is Purchase 
(ObjType in (20,22,540000006,18,19)) 
then CompanyRole='B'  
 

Documents.Address.type OPCH.ShiToCode Where Header.adderssType='SF' set 
Type=shipTo 

Documents.Address.country OPCH.CountryS Where Header.adderssType='SF' 
Documents.Address.region OPCH.StateS Where Header.adderssType='SF' 
Documents.Address.City OPCH.CityS Where Header.adderssType='SF' 
Documents.Address.county OPCH.CountyS Where Header.adderssType='SF' 
Documents.Address.postcode OPCH.ZipCodeS Where Header.adderssType='SF' 
Documents.Address.geocode OPCH.GlbLocNumS Where Header.adderssType='SF' 
Documents.Address.Type OWHS.ShiToCode Where Line.adderssType='ST' set 

Type=shipFrom 
Documents.Address.country OWHS.CountryS Where Line.addressType='ST' 
Documents.Address.region OWHS.StateS Where Line.addressType='ST' 
Documents.Address.City OWHS.CityS Where Line.addressType='ST' 
Documents.Address.county OWHS.CountyS Where Line.addressType='ST' 
Documents.Address.postcode OWHS.ZipCodeS Where Line.addressType='ST' 
Documents.Address.geocode OWHS.GlbLocNumS Where Line.addressType='ST' 
Documents.Currency OPCH.DocCur   
Documents.documentDate OPCH.DocDate   
Documents.Line.lineNumber PCH1.LineNum   
Documents.Line.productCode PCH1.StdItemId   
Documents.Line.commodityCode PCH1.CommClass   
Documents.Line.quantities PCH1.Quantity   
Documents.Line.taxableBasis PCH1.LineTotal   
Document.registrations.type  buyerRoll 
Document.registrations.registratio
nNumber 

OWHS.FedTaxId 
OADM.TaxIdNum, 
OADM.TaxIdNum2, 
OADM.TaxIdNum3, 

BuyerRegistration No  



 

Document.registrations.type  sellRoll 
Document.registrations.registratio
nNumber 

OCRD.VatIdUnCmp, 
OCRD.LicTradNum 

sellRegistration No 

Document.deliveryTerm.type  incoterms 
Document.deliveryTerms.term OPCH_TERM As per standard 

Response Payload Mapping Fields 

ONESOURCE REST API 
Fields 

Business ONE 
Fields Transformation/ Description 

Header.externalCompanyId TR_CONF1.U_INTID External company id is obtained from 
TR configuration screens and sent to 
REST API along with secret id/ key, 
which will be validated for further 
processing 

Header.companyRole   if the transaction type is Purchase 
(ObjType in (20,22,540000006,18,19)) 
then CompanyRole='B' 
 

documents.companyName TR_CONF1.CMNAME   
documents.companyRole   if the transaction type is Purchase 

(ObjType in (20,22,540000006,18,19)) 
then CompanyRole='B' 
 

Documents.currencyCode OPCH.DocCur   
Documents.externalCompanyId TR_CONF1.CMNAME   
Documents.transactionDate OPCH.DocDate   
Documents.totalTaxAmount OPCH.U_TAXAMT   
documents.callingSystemNumber TR_CONF1.U_INTID   
documents.hostName OADM.HostName   
documents.fiscalDate OPCH.DocDate   
documents.documentNumber OPCH.DocNumber   
documents.uniqueDocumentNum
ber 

TR_CONF1.U_INTID 
+ OPCH.DocNumber + 
companyRole + YEAR 

  

Documents.Line.lineNumber PCH1.LineNum   
Documents.Line.grossAmount PCH1.LineTotal   
Documents.Line.taxsummary.taxa
bleBasis 

PCH1.LineTotal   

Documents.Line.taxsummary.non
TaxableBasis 

  As per commoditycode or product code 

Documents.Line.taxsummary.exe
mptAmount 

  As per commoditycode or product code 

Documents.Line.taxsummary.tax
Rate 

PCH1.U_R As per effectiveZone 

Documents.Line.taxsummary.effe
ctiveTaxRate 

PCH1.U_R As per effectiveZone 

 

 

 

 

 

 

 



 

Documents.Line.transactionType OPCH.DocType Defaulted to GS 
Documents.Line.totalTaxAmount OPCH.U_TAXAMT   
Documents.Line.taxes.responseS
ummary 

  As per ship to and ship from Address 
and rule defined in TR Tax Engine 

Documents.Line.taxes.adminZone
Level 

  As per ship to and ship from Address 
and rule defined in TR Tax Engine 

Documents.Line.taxes.authorityTy
pe 

  As per ship to and ship from Address 
and rule defined in TR Tax Engine 

Documents.Line.taxes.authorityC
urrencyCode 

OPCH.DocCur   

Documents.Line.taxes.effectiveZo
neLevel 

  As per ship to and ship from Address 
and rule defined in TR Tax Engine 

Documents.Line.taxes.erpTaxCod
e 

  As per ship to and ship from Address 
and rule defined in TR Tax Engine 

Documents.Line.taxes.exemptAm
ount.authorityAmount 

  As per ship to and ship from Address 
and rule defined in TR Tax Engine 

Documents.Line.taxes.exemptAm
ount.documentAmount 

  As per ship to and ship from Address 
and rule defined in TR Tax Engine 

Documents.Line.taxes.grossAmo
untauthorityAmount 

  As per ship to and ship from Address 
and rule defined in TR Tax Engine 

Documents.Line.taxes.document
Description 

  As per ship to and ship from Address 
and rule defined in TR Tax Engine 

Documents.Line.taxes.jurisdiction
Text 

  As per ship to and ship from Address 
and rule defined in TR Tax Engine 

Documents.Line.taxes.nonTaxabl
eBasis.authorityAmount 

  As per ship to and ship from Address 
and rule defined in TR Tax Engine 

Documents.Line.taxes.nonTaxabl
eBasis.documentAmount 

  As per ship to and ship from Address 
and rule defined in TR Tax Engine 

Documents.Line.taxes.taxAmount
.authorityAmount 

  As per ship to and ship from Address 
and rule defined in TR Tax Engine 

Documents.Line.taxes.taxAmount
.documentAmount 

  As per ship to and ship from Address 
and rule defined in TR Tax Engine 

Documents.Line.taxes.taxRate   As per ship to and ship from Address 
and rule defined in TR Tax Engine 

Documents.Line.taxes.taxRateCo
de 

  As per ship to and ship from Address 
and rule defined in TR Tax Engine 

Documents.Line.taxes.taxableBas
is.authorityAmount 

  As per ship to and ship from Address 
and rule defined in TR Tax Engine 

Documents.Line.taxes.taxableBas
is.documentAmount 

  As per ship to and ship from Address 
and rule defined in TR Tax Engine 

Documents.Line.taxes.taxableCo
untry 

  As per ship to and ship from Address 
and rule defined in TR Tax Engine 

Documents.Line.taxes.addressTy
pe 

  As per ship to and ship from Address 
and rule defined in TR Tax Engine 

Documents.Line.taxes.authorityN
ame 

  As per ship to and ship from Address 
and rule defined in TR Tax Engine 

Documents.Line.taxes.authorityU
uid 

  As per ship to and ship from Address 
and rule defined in TR Tax Engine 

Documents.Line.taxes.euTransact
ion 

  As per ship to and ship from Address 
and rule defined in TR Tax Engine 

Documents.Line.taxes.natureOfT
ax 

  As per ship to and ship from Address 
and rule defined in TR Tax Engine 

Documents.Line.taxes.ruleOrder   As per ship to and ship from Address 
and rule defined in TR Tax Engine 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

Documents.Line.taxes.taxDetermi
nationDate 

OPCH.DocDate As per ship to and ship from Address 
and rule defined in TR Tax Engine 

Documents.Line.taxes.taxPointDa
te 

OPCH.DocDate As per ship to and ship from Address 
and rule defined in TR Tax Engine 

Documents.Line.taxes.taxType   As per ship to and ship from Address 
and rule defined in TR Tax Engine 

Documents.Line.taxes.taxableRe
gion 

  As per ship to and ship from Address 
and rule defined in TR Tax Engine 

Documents.Line.taxes.taxableCo
unty 

  As per ship to and ship from Address 
and rule defined in TR Tax Engine 

Documents.Line.taxes.taxableCity   As per ship to and ship from Address 
and rule defined in TR Tax Engine 

Documents.Line.taxes.taxableGe
ocode 

  As per ship to and ship from Address 
and rule defined in TR Tax Engine 

Documents.Line.taxes.taxablePos
tcode 

  As per ship to and ship from Address 
and rule defined in TR Tax Engine 

Documents.Line.taxes.zoneName   As per ship to and ship from Address 
and rule defined in TR Tax Engine 

Documents.Line.taxes.zoneLevel   As per ship to and ship from Address 
and rule defined in TR Tax Engine 

Documents.Line.taxes.ZoneFipsC
ode 

  As per ship to and ship from Address 
and rule defined in TR Tax Engine 

Documents.Line.quantities.amoun
t 

PCH1.Quantity   

Documents.Line.quantities.uom PCH1.unitMsr   
Document.registrations.type  buyerRoll 
Document.registrations.registratio
nNumber 

OWHS.FedTaxId 
OADM.TaxIdNum, 
OADM.TaxIdNum2, 
OADM.TaxIdNum3, 

BuyerRegistration No 

Document.registrations.type  sellRoll 
Document.registrations.registratio
nNumber 

OCRD.VatIdUnCmp, 
OCRD.LicTradNum 

sellRegistration No 

Document.deliveryTerm.type  incoterms 
Document.deliveryTerms.term OPCH_TERM As per standard 

 
 

Sample Transaction (Sales) 
In this section, we will walk through a sample transaction from Sales Quotation to A/R Invoice 
process (Order-to-Cash - O2C) using the SAP Business One integration with ONESOURCE 
Determination. This solution covers various stages of the sales process, including Sales Quotation, 
Sales Order, A/R Invoice, Invoice cancellation, and Credit Note. 
 
Throughout this Order to Cash process, the integration with ONESOURCE Determination ensures 
accurate tax calculations based on the jurisdiction and tax rules. The tax amounts are automatically 
determined and applied to the respective documents, providing compliance and accuracy in tax 
calculation. 
 

 

 

 

 

 

 

 

 

 

 



 

Sales Quotation 

Start with creating a Sales Quotation: Enter the relevant details such as customer information, items, 
quantities, prices, and any applicable discounts. Once the Quotation is prepared, you can save it for 
further processing. 
 
In this example, we will use a customer with a ship-to address as follows: 
 

• Country: FR 
• State:  
• City: FR 
• Buyer Registration No: FR09417760155 

Please note that this is a sample address used for demonstration purposes, and you should enter 
the actual customer's ship-to address when performing the transaction in your SAP Business One 
system. 
 

 
 
The ship-from location for this transaction is as follows: 
 

• Country: FR 
• City:  
• Seller Registration:FR801161988B01 

Please ensure that you enter the accurate ship-from location details based on your specific scenario 
in SAP Business One. 
 

Sales Quotation

Customer TOO0500
Name Paris, FR
Contact Person
Customer Ref. No.
Local Currency

Address Component

Logistics Accounting
Street / PO Box

Contents Attad Street No.

Ship To PARIS
Paris City Paris

Zip Code
County

Bill To State
Country/Region France
Building/Floor/Room

Shipping Type
Address Name 2

Delivery Term
Address Name 3
GLN

OK Cancel

 

  
  

 
 

 

 

  
 

   

  
   

 
 

  
  

 

 
 

 
 

 

 



 

 
 
 
 
For the line item of the transaction: 
 

• Product Code: ITM0001 
• Commodity Code: [Please provide the commodity code if available] 

• Quantity: 1 

• UOM (Unit of Measure): Each 

• Taxable Value (Line Total): 1000 EUR 

 
Please note that the commodity code should be specified if applicable. 
 
 

 
 

Sales Quotation
Warehouses-(Default) - Setup

Customer CUS0001
Name Paris, FR Warehouse Code[01 Warehouse NameParis
Contact Person
Customer Ref. No. General Accounting
Local Currency

 Inactive  Drgp-Ship

Location  Nettable

Contents Logistics Accounting Att Consignment Business Partner
Item/Service TypeItem
# Item No.  Item DescriptionQuantity Unit Price Discount % kel

ITM00001 Item 1 1,000.00000 EUR 0.00N/A Street/PO Box
0.00ON Enable Bin Locations

Block
Building/Floor/Room
Zip Code

City Paris
County
Country/Region France
State
Federal Tax ID FR801161988B01

GLN Show Location in Web B

Tax Office
Address Name 2
Address Name 3

Sales Employee No Sales Employee* OK Cancel

Sales Quotation

Customer CUS0001
Name Paris, FR
Contact Person
Customer Ref. No.

Local Currency

Contents Logistics Accounting Attachments

Item/Service Type Item
# Item No. Item Description Quantity Unit Price Discount % o xe Total (LC) Whse UoM Code COGS Distr. Rule Count
1 ITM00001 Item 1 1 1,000.00000 EUR 0.00N/A 1,000.00 EUR 01 EACH
2 0.00 ONA

 
 

  
     

 
   

 
  

  

     
  

       

      
   

 
 

 
  

 
  

 
  

  
 

 
 

   

 

  
  

 
 
 

    

  

            

         
  



 

After saving the transaction, we can see that the tax amount applied is 200 EUR. This tax amount is 
calculated only on the product value and not on the freight charges. The reason for the exemption of 
tax on the freight charges is based on the rules configured within ONESOURCE Determination. 
 
Additionally, the tax calculation correlation id for this transaction is - 149_20230809144251. This 
correlation id is used as a reference when analyzing logs and troubleshooting issues. 
 

 
 
The tax amount for each line item will be updated at the line level, indicating the tax applied 
specifically to that item. Additionally, the tax amounts of all the line items will be summarized based 
on the applied tax authority zone levels. These summarized tax amounts will be saved in the "Sales 
Tax and Freight" table, offering a detailed breakdown of taxes categorized by tax direction types 
such as Output Value Added Tax (oVAT), and Input Value Added Tax (iVAT) 
 
Sales Order 
After creating the sales quotation, you can copy the document to a sales order. In the sales order, 
you will not make any changes to the values except for updating the delivery date. Simply click on 
the "Add" button to save the sales order. At this point, the system will send a tax calculation request 
to the TR Tax engine. Once the tax calculation is completed, the system will update the tax amounts 
for each line item, along with the correlation id, and save the document. 
 
The tax amount for each line item will be updated at the line level, indicating the tax applied 
specifically to that item. Additionally, the tax amounts of all the line items will be summarized based 
on the applied tax authority zone levels. This summarized tax information will be saved in the "Sales 
Tax and Freight" table, providing a breakdown of taxes by tax authority levels. 
It is important to note that at this stage, no actual tax will be posted in SAP, as taxes are only 
applicable during the invoice stage. 
 
 
 
 

Sales Quotation

Contents Logisties Accounting Attachments

Item/Service TypeItem Summary TypeNo Summary
Item No.  Item DescriptionQuantity Unit Price Discount %apoo xeTotal (LC) WhseUoM CodeCOGS Distr. RuleCountry/Region of Origin Blanket Agreement No.Allow Procmnt. Doc.VAT RateVAT...

ITM00001 Item 1 1,000.00000 EUR 0.00N/A 1,000.00 EUR EACH 0.20
0.00ONA

Sales Employee-No Sales Employee-ÿ ÿ Total Before Discount 1,000.00 EUR
Owner Discount %
Tax Amount 200.00 Sales Tax & Freight 200.00 EUR
Correlation Id 149_20230809144251  Rounding

Tax

 

    

    
           

       
  

  
   

   
    

   



 

Sales Invoice (A/R Invoice) 

After copying the sales order to an A/R Invoice, click on the "Add" button to save the invoice. At this 
point, the system will once again send a tax calculation request to the TR Tax engine. Once the tax 
calculation is completed, the system will update the tax amounts for each line item, along with the 
correlation id, and save the document. 
 
Once the A/R Invoice is posted, the system will send the tax details to the TR Audit Database for 
reporting, global compliance, reconciliation, and data analysis processes. This process is known as 
the "Commit call".  
 
Similar to previous stages, the tax amount for each line item will be updated at the line level, 
reflecting the tax applied to each specific item. The tax amounts of all the line items will be 
summarized based on the applied tax authority levels, and this breakdown will be saved in the 
"Sales Tax and Freight" table. This provides a comprehensive view of the taxes applied, categorized 
by tax authority levels. 
 

 

A/R Invoice
Contact Person Posting Date 04.09.2023
Customer Ref. No. Due Date 04.09.2023
Local Currency Document Date 04.09.2023

Contents Logisties Accounting Attachments

Item/Service TypeItem ÿ Summary TypeNo Summary
Item No.  Item DescriptionQuantity Unit Price  Discount %() leol ap0 xe1  Freight 1 Freight 1 (LC) Freight 1 Ta...
TO00001I Item 1 1 1,000.00000 EUR 0.00ONA 1,000.00 EUR

0.00ONA

Sales EmployeeNo Sales Employee-ÿ Total Before Discount 1,000.00 EUR
Owner Discount %
Tax Amount 0.00 Total Down Payment
 Correlation Id Sales Tax & Freight 200.00 EUR

 Rounding 0.00 EUR
xe1

 Payment Order Run Total 
Based On Sales Orders

1,200.00 EUR
Remarks

UFUUUEUCL Applied Amount

 
   

   
   

    

     
         

  
    

 

  
 

  
   

   
   

  
 

 
 

 
  



 

 

Sample Transaction (Purchase) 
Purchase Quotation 

Here we have taken a Vendor called “V002” with its ship from address as  
• Country – FR 
• City – Paris  
• Seller Registration - FR09417760155 

 

 
 
The ship To Location is.  

• Country – FR 
• City – Paris 
• Buyer Registration: FR801161988B01 

 

Sales Tax & Freight

Do Not Display Freight Charges with Zero Amount

# Freight Name Remarks Tax Group % xe1 TotalTaxAmount Distrib.Method Net Amount BaseDocument Status

TR_oVAT ONA 0.00 0.00 EUR None 200.00EUR 230300022 C

200.00 EUR

OK Cancel

Purchase Quotation Business Partner Master Data

Vendor >SUP00001 apo Supplier SUP00001 Vendor Local Currency No. 23PQ 230500005
Name Supplier 1 Name Supplier 1 Account Balance -1,000.00ÿ Status Closed
Contact Person ÿ Foreign Name Goods Receipt POs 0.00  Posting Date 30.08.2023
Vendor Ref. No. Group Vendors Purchase Orders -8,655.00ÿ Valid Until 30.08.2023
Local Currency Currency All Currencies Document Date 30.08.2023
Group No. 23PQG230600005 ÿ Federal Tax ID FR09417760155 Required Date 30.08.2023

GeneralContact PergonsAddresses Payment TermsPayment RunAccguntingPropertjesRemarks AttachmentsContents Logistics

Item/Service TypeItem Pay To Ship To Show Location in Web Browser Summary TypeNo Summary
Item No.  Item Description Required Date  Define New Address ID Ship From - Paris Blanket Agreement No.VAT RateVAT ...

ITM00001 Item 1 30.08.2023 Ship To Address Name 2
Address Name 3

0.20
 Ship From - Paris
Define New Street/ PO Box

Block
City sued
apop dz
County
State
Country/Region France
Federal Tax ID FR09417760155

Hneyao se 1a5 Street No.

Buyer No Sales Employee* Total Before Discount 1,000.00 EUR
Owner Discount %
Tax Amount Purchase Tax & Freigh > 200.00 EUR
Correlation Id 540000988_20230830204711  Rounding

Tax

 

 

          

        

 

 

  

          
         

       
       
     

   
     

           

       
        

     
 

 
 

  
 

  
 
 

 
  

  
  

    
   

  
   



 

 
 
Line Items 

• Product Code – ITM0001 
• Commodity Code  
• Quoted Quantity – 1 
• UOM – Each 
• Unit Price – 1000 EUR 
• Taxable Value (Line Total) – 1000 EUR 

 

Warehouses-(Default) - Setup
Warehouse Code 01 Warehouse Name Par's

General Accounting

Inactive  Drgp-Ship

Location Nettable

Consignment Business Partner

Street/PO Box
Street No.  Enable Bin Locations
Block
Building/Floor/Room
Zip Code
City Paris
County
Country/Region France
State ÿ

Federal Tax ID FR801161988B01
GLN Show Location in Web Browser
Tax Office
Address Name 2
Address Name 3

 

    

  

  

  

 

 
  

 
 

 
  

 
  

  

  
  

 
 



 

 
 
After entering the details and clicking on the calculate button, or trying to add/ save the document, 
the system will calculate the tax. In this example, we found that the tax amount is EUR 200. After 
saving the transaction, we can see that the tax amount of EUR 200 is applied to the product value 
according to the TR Tax rule based on the ship-from and ship-to addresses.  
 
The tax amount for each line item will be updated at the line level, and the total tax amount for all 
line items will be summarized based on the applied tax authority levels. This information, including 
the breakdown of taxes and freight charges, will be saved in the "Sales Tax and Freight" table for 
further reference and analysis. 

Purchase Order 

After copying the purchase quotation to a purchase order and saving it without any changes except 
for the delivery date, the system will send a tax calculation request to the TR Tax engine. Once the 
calculation is completed, the system will update the tax calculation for each line item and save the 
document with the assigned correlation ID. 

Purchase Quotation

Vendor >SUP00001 No. 23PQ 230500005
Name Supplier 1 Status Closed
Contact Person  Posting Date 30.08.2023
Vendor Ref. No. Valid Until 30.08.2023
Local Currency Document Date 30.08.2023
Group No. 23PQG 230600005 Required Date 30.08.2023

Contents Logisties Accounting Attachments

Item/Service TypeItem Summary TypeNo Summary
Item No. Item Descripti.  Required DateQuoted DateRequired Qty.Quoted Qty. Unit Price D

ITM00001 Item 1 30.08.2023 30.08.2023 1 1 1,000.00000 EUR

Buyer No Sales Employee- Total Before Discount 1,000.00 EUR
Owner Discount %
Tax Amount 200.00 Purchase Tax & Freigh > 200.00 EUR
Correlation Id 540000988_20230830204711 Rounding

Tax
-U 1-+1 n+ Duia 1 3nn nn cuol

 

     
    

   
   

   
     

    

    
       

       

    
   

    
   

 
  



 

The tax amount for each line item will be updated at the line level, and the total tax amount for all 
line items will be summarized based on the applied tax authority zone levels. This information, along 
with the breakdown of taxes and freight charges, will be saved in the "Sales Tax and Freight" table. 
At this stage, no actual tax will be posted in SAP as taxes are only applicable during invoice 
processing. 
 

 

Purchase Invoice (A/P Invoice) 

After copying the purchase order to an A/P invoice and saving it without any changes, except for 
clicking on the "Add" button, the system will perform several checks. Firstly, it will verify if the user 
has entered any Vendor Central Tax (VCT) amount. If no VCT amount is entered, the system will 
prompt the user for confirmation. 
 

 Purchase Order

Vendor >SUP00001 No. 23PO 230700010
Name Supplier 1 Status Closed
Contact Person  Posting Date 30.08.2023
Vendor Ref. No. Delivery Date 30.08.2023
Local Currency Document Date 30.08.2023

Contents Logisties Accounting  Attachments
Item/Service TypeItem Summary TypeNo Summary

Item No.  Item Description Quantity Unit PriceDiscount % Tax Code Total (LC)
ITM00001 Item 1 1 00.00000 EUR 0.00INA 1,000.00 EUR

Buyer No Sales Employee- Total Before Discount 1,000.00 EUR
Owner Discount
Tax Amount

%
200.00 Purchase Tax & Freigh 200.00 EUR

Correlation Id 142_20230830204731  Rounding
xe1
"-u 1-=1 1 3nn nn cIID

 

     
    

   
   

   

    

    
     

    

    
  

 

 
  

   
 

 



 

The purpose of this check is to ensure that the VCT amount is properly entered and considered for 
tax calculation. It helps prevent any errors or omissions in the VCT amount, ensuring accurate tax 
determination for the invoice. 
 

 
If the user forgets to enter the Vendor Central Tax (VCT) amount, they need to click on the "Cancel" 
button. However, if there is no tax charged by the vendor, the user can click on "OK" to proceed. In 
this case, the system will send a tax calculation request to the ONESOURCE Determination. Once 
the calculation is completed, the system will update the tax calculations along with the correlation ID. 
 
The VCT accrual method will be determined based on the VCT configuration and the given VCT 
amount. The accrual method can be one of the following: 
 

• Hold Payment 

If the accrual method is "Hold Payment," the system will not allow the user to post the transaction 
until they modify the details, or the system receives a different accrual method. In this scenario, the 
system will allow the user to save the document in Draft if desired, and they can use the draft 
document later. 
 
After the A/P Invoice is posted, the system will send the tax details to the TR Audit Database for 
reporting, global compliance, reconciliation, and data analysis processes. This process is known as 
the "Commit call." At this stage, the actual tax amount is booked in the database, and the tax 
information will be saved in the TR audit database. 
 
The tax amount for the line items will be updated at the line level, ensuring that each line reflects the 
appropriate tax calculation. Additionally, the tax amount for all line items will be summarized based 
on the applied tax authority zone levels. This summary will be saved in the "Purchase Tax and 
Freight" table, providing a breakdown of the tax amounts based on different tax authority levels. 
 

System Message X

Vendor TaxAmountiszero,Do youwant toproceed ?

Ok Cancel

  

  

 



 

 
 
After the A/P Invoice is posted, the system will create the necessary accounting entries for the 
transaction. The tax amount will be included in these accounting postings. Specifically, the tax 
amount will be recorded in a clearing account. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

A/P Invoice
Vendor >SUP00001 No. 23AP 230800003
Name Supplier 1 Status Closed
Contact Person Posting Date 30.08.2023
Vendor Ref. No. Due Date 30.08.2023
Local Currency Document Date 30.08.2023

Contents Logistics Accounting Attachments

Item/Service TypeItem Summary TypeNo Summary
Item No. Item Descript..  QuantityUnit Price Dis...Tax Code Total (LC)

ITM00001 Item 1 1 1,000.00000 EUR0.00INA

Buyer No Sales Employee-ÿ Total Before Discount 1,000.00 EUR
Owner Discount %
Tax Amount 200.00 Total Down Payment
Correlation Id 141_20230830204801Purchase Tax & Freigh 200.00 EUR
Vendor Tax Amount 0.00 Rounding

 
     

    
   

   
   

    

    
    

     

   
  

   
   

   
  



 

Journal Entry in A/P Invoice 
 

 

 
 

Journal Entry
Series Number Posting Date Due Date Doc. Date Remarks
Primary 30 30.08.2023 30.08.2023 30.08.2023 A/P Invoices - SUP00001
Origin Origin No. 'ON 'Se1 Template Type Template Indicator palosd

PU E00000007 [30
Trans. Code Ref. 1 Ref. 2 Ref. 3

E00000007

Blanket Agreement

Contents Attachments

Expand Editing Mode

G/L Acct/BP Code G/L Acct/BP Name Control Acct Debit Remarks TemplateTax GroupReceipt Nur
SUP00001 Supplier 1 ÿ 401100 1,200.00 EUR
445620 TVA deductible sur immobilisation ÿ 445620 0.00 EUR INA

3 ÿ 371000 Stock de marchandises ÿ 371000 1,000.00 EUR

4 603700 Variation des stocks de marchandises603700 1,000.00 EUR
5 607100 achats de marchandises 607100 1,000.00 EUR
6 445710 T.V.A. collectee 445710 200.00 EUR

Relationship Map

Business Partners Purchase Order
SUP00001

Supplier 1 230700010
30.08.2023

1,200.00 EUR
A/P Credit Memo

Purchase Quotation A/P Invoice
230900001

230500005 230900003 30.08.2023

30.08.2023 30.08.2023
1,200.00 EUR

1,200.00 EUR 1,200.00 EUR

Marketing Document: Document Tree
OK Go Back Go Forward  Referenced Documents
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